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Introduction

What's in this Manual

This manual provides a menu-by-menu, screen-by-screen listing of
controls and settings available with FlexColor.

Topics include:

• Summaries of all menu commands

• Description of the 3f file format

• Information about rotating and mirroring images

• Image management from the Thumbnails Window

• Full details of all tab sheets in the Setup window

• Full details of the Preferences window

• Instructions for editing ColorSyncTM profiles

• Brightness and contrast control with the Gradations window

• Advanced highlight and shadow settings with the Histogram window,
including color neutralization and control

• Advanced color control with the Color Correction window

• Sharpening images with the Texture window

Software compatibility

The FlexColor software works with the entire range of Ixpress and
FlexFrame digital camera backs and all Flextight scanners except for the
Flextight 4800.

FlexColor under Mac OS and Windows

The CD that came with your digital camera system includes versions of
FlexColor for both Macintosh and Windows-based systems.
The interface is nearly identical on both platforms, with mostly superficial
differences to conform with the interface guidelines of the two systems.
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Nearly all of the screen captures shown in this manual were taken from
Mac OS X. Windows users will notice the following differences:

• In the Setup window, the color management tab is called ICM instead
of ColorSyncTM.

• The menus are located at the top of the main FlexColor window instead
of at the top of the screen.

System Requirements

IBM PC-Compatibles

• Minimum 233 MHz processor.

• Windows 2000 or XP.

• System RAM
512 MB or more recommended - when performing micro step captures
we recommend at least 1.5 GB. Ixpress 528C will not function with less
than 2 GB.

• Screen resolution of 800 x 600 pixels with true colors (24 bits).

• Mouse or other pointing device.

• FireWire interface
or
SCSI Interface.

• Minimum available hard disk space of 10 GB

Macintosh

• Minimum Power PC processor.

• Mac OS X ver. 10.2.1 or later.

• System RAM
512 MB or more recommended - when performing micro step captures
we recommend at least 1 GB.

• Screen resolution of 800 x 600 pixels with true colors (24 bits).

• FireWire interface
or
SCSI interface.

• Minimum available hard disk space of 10 GB.
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OS X Requirements

OS X V 10.2.1 or later is required. We recommend updating to the latest
release available.

Devices can be connected by either SCSI or FireWire. Please note that if
you are connecting a SCSI device through a SCSI to FireWire device it will
be represented as a FireWire device - that is the bus number in the device
window will be 9.

To be recognized by OS X, devices connected to a standard SCSI adapter
must be present when booting the Mac.
A SCSI device connected via a SCSI to FireWire adapter will be recognized
when the adapter is plugged in.
The SCSI device itself must be turned on before connecting the adapter to
FireWire or rebooting.
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The 3f File Format

When using the Scan 3f function (for scanners) or capturing an image
with a digital camera back, FlexColor stores the image in the unique 3f
(flexible file format).

The 3f file is an extended TIFF-file containing

• Raw 16-bit image data

• A complete history of applied settings

• High quality preview image

• Custom icons and previews visible in the Finder.

• Meta-data (including IPTC tags) to support an image database.

In short this means that when you have scanned or captured your image,
you can crop, resize and color correct an unlimited number of times
afterwards.
You can easily integrate to databases, have fast previews in a number of
applications and always be able to re-create the quality you need - all this
from the same 3f file.

Image Archiving & Availability

Because a 3f file preserves all of the details captured by your scanner or
camera, it is perfect for archiving. Then, for each new job, you will work
with the 3f image in FlexColor and export it to create a new TIFF file in
which your settings are applied - the only change made to the 3f file will
be the addition of a new history record of the settings you used.

By making the 3f files available over your network, you will enable
operators at any workstation to open an image in FlexColor and apply
cropping, correction and conversion just as though they were working
directly on the scanner or camera.
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Editing 3f Files

FlexColor holds all tools required for making standard image correction
of the 3f files.
If you need to apply pixel-editing to your image, FlexColor has a special
plug-in for Photoshop. When installing FlexColor, this plug-in will be
installed in the appropriate plug-in folder if Photoshop is already
installed.
Please note that you will permanently alter your original scanning or
capture data when you save using the plug-in.

To use your images in other image-editing and DTP applications, you
must apply the required settings and then save them as TIFF files. TIFF is
a standard format that is supported by the vast majority of imaging and
DTP programs.

IPTC Tags

The International Press Telecommunications Council (IPTC) defines a
standard used in the press industry for exchanging meta-information in
news content, including images. The standard associates an object with its
description within the same file. You can embed all kinds of information
in your images, such as a caption, the place you took it, the date and even
keywords and categories etc.

In FlexColor you are able to apply a number of IPTC-tags to your 3f files.
See “The Info Window” on page 65 for details.
An extra copy of the IPTC data is stored in the Adobe Image Resource tag
to enable Extensis Portfolio and other applications extracting metadata
with QuickTime to read the keywords stored in the standard IPTC tag.

Many aspects of managing your images are made easier using the IPTC
standard. Many software programs already exist for doing this, including
Adobe Photoshop. It’s the standard used by professional news agencies
worldwide, and it’s just as useful for others.

Software Reference - FlexColor 4.0 for Camera Backs

Introduction
11

The 3f File Format



Software Reference - FlexColor 4.0 for Camera Backs

Introduction
12



FlexColor Menus

FlexColor commands are available via a standard menu bar. Each of them
is described briefly below. Note that most menu entries also list a
keyboard shortcut to the right of the entry. Try to remember and use these
shortcuts to speed up your work.

The FlexColor Menu

Except for the Preferences entry the FlexColor menu functions are
standard for all applications.

• Preferences: Opens the Preferences window, which enables you to
make general flash and shutter settings for your current camera model,
select an application for viewing final images, and typing some default
information for the 3f files.
See "The Preferences Window" on page 47 for more information.
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The File Menu

The File menu includes entries that initiate image captures and make
settings for FlexColor.

• Capture: Captures an image using your current settings and saves it as
a 3f file (see page 10 for details). A preview of the image will be
displayed in main FlexColor window right away, though rendering of
the image will continue in the background for several seconds
afterwards. You will not be able to view the image in full resolution
until the rendering is finished, though you can make other types of
settings. All setting are previewed using the full 16-bit color depth to
display results.

• Save: Saves the image currently shown in the FlexColor window as a
standard TIFF file. All current crop, mode, color and image-
enhancement settings will be applied to the saved image.

• Close: Closes the currently selected window if possible.

• Setup: Opens the Setup window, in which most of the basic settings for
an image capture can be made, saved and loaded.
See "The Setup Window" on page 29 for more information.
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• Devices: Opens the Devices window.

The window lists all connected devices allowing you to select which
camera or scanner device you want to work with. Click on the one you
prefer and click the Select button. If you have only a single scanner or
camera connected this device is automatically chosen.
The numbers just to the right of the scanner or camera icon in the list
(ex. 0-5) refers to the Bus no. (0) and the SCSI address (5).

• Get Info: Opens an Info window, which contains various information
about the currently selected image.
See "The Info Window" on page 65 for a detailed description.

• Page Setup.../Print… : Enables you to print the contents of the
Thumbnails window. Make sure you have selected the view by
clicking on an image in the window, then select Print.
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The Edit Menu

The Edit menu contains entries that enable you to undo multiple actions
that you have made while making settings in FlexColor. It also enables
you to cut, copy and paste text in various windows.

• Undo: Reverses your most-recent actions - for example, a crop area
modification or a change in the Setup window. You are able to step
back through a long series of actions.

• Redo: Reapplies the last action that you cancelled using the Undo
command.

• Cut: If you have selected some text in a text field, then this command
removes the text and saves it on a system-wide virtual clipboard.

• Copy: Saves the selected text on the clipboard without removing it.

• Paste: Places a copy of the text on the clipboard at the insertion point.

• Clear: Removes all text from the clipboard.

• Select All: Selects all of the text contained in the field in which the
insertion point is standing. In the Thumbnails window, this selects all
of the icons in the window (see "The Thumbnails Window" on page 61).

• Deselect: Removes the cropping of the currently shown image.

• Show Clipboard: displays the current contents of the clipboard.
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The Modify Menu

The Modify menu gives you quick short cuts to functions that are also
available from within the modify dialog in the Thumbnails window (see
page 61 for details).
You have the possibility to select a number of files and choose Process
from the Modify menu. This will add a corresponding number of
processing tasks to the list in the Task window and processing of those
files will take place in the background. Processing tasks will not be
interrupted by new image captures.

Batch Modify

When using the Batch Modify... function to add settings from current
settings the cropping will be maintained in the added settings.
If the images in question have different sizes the cropping will be scaled
accordingly.

Neutralization presets

You have the ability to save and reuse named neutralization presets. This
feature is also accessible from the Modify dialog in the Thumbnails
window (see page 67 for details).
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The View Menu

The View menu exposes some of the “secret” short cuts that relate to the
control of grid, overlay and crop mask and to zooming and selection of
images.

The Soft Proof feature combines the ICC color profile of your monitor
with the profiles of your camera back and output device to provide a
simulation of the output colors on your screen. Enable this only when you
are sure about the specific output device you are using. If you are making
a general-purpose RGB capture, then keep this feature unselected.
A small s to the right of the Color Info area in the main FlexColor
window indicates that Soft Proof is enabled.

The Hide Tools item lets you hide all tool windows.

The Maintenance Menu

The Maintenance menu is not available when you use FlexColor with a
digital camera back.
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The Window Menu

The Window menu opens and closes each of the image settings windows
available with FlexColor. Each window that is currently open shows a
check mark to the left of its name. For more information about each of
these windows, see the appropriate section later in this manual:

Gradations window . . . . . . . . . see page 87.
Histogram window . . . . . . . . . . see page 93.
Color Correction window . . . . see page 99.
Texture window . . . . . . . . . . . see page 101.
Detail window. . . . . . . . . . . . . see page 105.
Exposure window . . . . . . . . . . . see page 79.
Thumbnails window . . . . . . . . see page 61.
Color Info window . . . . . . . . . . see page 83.
Live Video window . . . . . . . . see page 107.
Tasks window . . . . . . . . . . . . . see page 111.

NOTE! The Batch Scan entry is not available when you use FlexColor
with a digital camera back.
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The Main FlexColor Window

Introduction

The main FlexColor window displays your preview images and provides
access to most of the image capturing and editing functions available with
FlexColor.

Capture and Save Tools

Capture Captures an image using your current settings.
A preview of the image will be displayed in the main
FlexColor window right away.
All settings are previewed using the full 16-bit color depth to
display results.
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Save Saves the image currently shown in the FlexColor window
as a standard TIFF file. All current crop, mode, color and
image-enhancement settings will be applied to the saved
image. The save task is added to the list in the Tasks
window (see page 111 for details) and the actual save task
will take place in the background

Previous/Next Image Buttons: Use these buttons to select
previous or next image from the thumbnails folder.

Ixpress Contents Button: Opens the Ixpress Contents
window displaying thumbnails of all images currently
stored on the Image Bank's hard disk.

Thumbnails Button: Opens the Thumbnails window, which
displays thumbnail images of all of the images saved in the
current folder. See "The Thumbnails Window" on page 61 for
more information.

Setup Use this pop-up menu to choose between any of the
currently available setups. A small + will appear to the right
of the menu to indicate when you have made custom
changes that affect the setup but have not been saved.

Type Use this pop-up menu to choose the type of capture you
want to make (preview, single-shot, multi-shot or
micro-step). This setting mirrors the Type setting on the
General tab of the Setup window.
See "General Tab" on page 32 for more information.

Mode Use this pop-up menu to set the capture mode (RGB, RGB
16 bit, Grayscale, Grayscale 16 bit, Lineart, or CMYK). This
setting mirrors the Mode setting on the General tab of the
Setup window.
See "General Tab" on page 32 for more information.

Keyboard shortcuts

See "Appendix" on page 113 for related keyboard shortcuts.
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Color and Exposure Analysis Tools

Use the exposure-level indicator to get a rough idea of how bright your
picture is. Ideally, it should be near the top of the green area, but without
entering into the red area, which indicates an overexposure. The indicator
turns yellow to indicate a probably bad exposure and turns white to
indicate a good exposure. Only the part of the image that is inside of your
crop area is measured by this tool, which means that the measurement
will change when you modify the crop area.

The various pixel value displays give you the f-stop and/or color values
for the pixel currently under the mouse pointer in the preview. Use this
tool to evaluate the exposure in particular areas of the captured image.
When you are shooting in RGB mode, then you can read values for each of
the three colors and the f-stop brightness, as shown above. However, if
you are shooting to CMYK, then CMYK pixel values are shown, and no
f-stop value appears. Use the Color Info window to read CMYK and
f-stop values simultaneously (see below).

The Neutralize color picker helps you to obtain a neutral color balance in
your image (see “Neutralizing Colors" on page 98 for details).
Next to the information displays are two buttons, which will open
windows that give you even more information and control. These are:

Exposure Button: Click this button to open the Exposure
window, which enables you to assess your exposure, set
camera aperture, exposure time and ISO sensitivity, and
make a black calibration. See "The Exposure Window" on
page 79 for more information.

Color Info Button: Click this button to read pixel values
from several points in the preview image. See "The Color
Info Window" on page 65 for more information.
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Corrections Controls

Gradation Button: Opens/closes the Gradations window.
See "The Gradations Window" on page 87 for more

information.

Histogram Button: Opens/closes the Histogram window.
See "The Histogram Window" on page 93 for more
information.

Color Correction Button: Opens/closes the Color
Correction window.
See "Selective Color Correction" on page 99 for more
information.

Texture Button: Opens/closes the Texture window.
See "The Texture Window" on page 101 for more
information.

Auto Button: Click this button to apply automatic settings
for highlight and shadow points based on the histogram of
your image.

Reload Button: Click on this button to return all correction
windows (Gradations, Histogram, Color Correction, and
Texture) to the settings saved with the current setup.

Size Controls

Width The measured width of the output image. The units used are
set on the General tab of the Setup window. See "General
Tab" on page 32 for more information.

Height The measured height of the output image. The units used are
set on the General tab of the Setup window. See "General
Tab" on page 32 for more information.

Zoom The level of magnification applied when the image is saved.
The Width and Height settings will update to reflect the
setting you make here. Note that if you choose a setting
other than 100%, then FlexColor will interpolate the image to
fit the size you specify.

Size The file size of the final image file. This is affected by the
Width, Height, Zoom, and PPI settings.
It is possible to type a desired output file size. This will
adjust the zoom percentage correspondingly (max. 200%).
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PPI The output resolution of the final image. The Width and
Height settings will update to reflect the setting you make
here.

Lock Button: The lock button enables you to lock the output
width and height settings. When the lock is closed, then the
output width and height will not change when you modify
the crop area by dragging one of its corners, and the
proportion of height to width will be maintained. Click on
the lock to toggle its setting.

Crop Button: Usually this button is gray, which indicates
that the crop tool is active. When the crop tool is active, you
are able to click and drag on the preview image to create and
manipulate the crop area. However, some tools, such as the
color pickers, change the cursor so that it selects colors
instead of defining a crop area. When one of these tools is
active, the crop button is white. To return to the crop tool,
click on the crop button.

Note the following points about working with the crop and size tools:

• When you work with the digital camera, you will typically know the
target output dimensions and resolution. If so, first enter the
dimensions in the Height and Width fields and choose the output
resolution from the PPI pop-up menu. Then click on the lock icon so
that it is closed (this will lock your height and width settings).
You are now able to click and drag the crop area to define the
composition of your image - the Zoom value automatically tracks your
changes without changing the height, width, or PPI of your output
image.

• To set the crop area, place the mouse cursor over the preview image.
Click and hold over one corner of the area you wish to capture and drag
the cursor away to outline the area. Release the mouse button to select
the area.

• To move the crop area, place the mouse cursor inside the outline, then
click and drag the area. Release the button to drop the area again.

• To resize the crop area, place the mouse cursor over one of the sides or
corners. The cursor will change into a double sided arrow. Click and
drag the side or corner to stretch or shrink the area.
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Zoom Controls

Zoom Out: Click this button to make the preview image
smaller.

Zoom In: Click this button to make the preview image
larger.

Fit to Window: Click this button to resize the preview to fit
the window.

Detail: Click this button to open the Detail window. Use this
window to show details of the image and/or a strongly
magnified view of the preview image for reading color
values of a specific pixel in your image. See "The Detail
Window" on page 105 for more information.

Keyboard shortcuts

See "Appendix" on page 113 for related keyboard shortcuts.

Orientation Controls

Rotate Buttons: If you choose to shoot with the camera back
in portrait mode, then your subjects will be rotated so that
they appears sideways in relation to the FlexColor preview
window. If this annoys you, the use the rotate buttons to
rotate the image in 90° steps in either direction. Both the
preview and the final image will be rotated.

Mirror Button: Mirrors the preview and final image.

Orientation Icon: Shows the current rotation/mirroring in
relation to the captured image.

Keyboard shortcuts

See "Appendix" on page 113 for related keyboard shortcuts.
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Other Controls

Grab tool: Holding down space activates the grab tool
allowing you to drag the contents of the preview window
around.

Crop mask button: Masks off the area outside the current
cropping.

Overlay Button: Switches on and off the display of an
overlay over the image in the preview window.
Activating this button without actually having added an
overlay image will display a message describing this.
See page 28 for details about adding an overlay to the image.

Opacity slider: This slider occurs below the overlay button
while the overlay is active. The slider gives you full control
of the overlay image transparency.

Grid Button: Adds a grid over the preview and live video
window. The grid can be useful for aligning objects in your
setup.
Holding down the option key while clicking the button
opens the Grid options window:

Here you are able to define the number and color of the lines
in the grid.
The number of lines is per the smallest image dimension
(width or height).

Scrolling

The scroll wheel on your mouse can be used in the preview window -
hold down option key to scroll sideways.
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Overlay

It is possible to add an overlay to the preview and live video windows to
help with aligning your setup. All the standard image file types such as
TIFF, JPEG, GIF, and PNG can be used.

The Mac version supports PNG-files with alpha channels giving you full
control of the image transparency.

To add the overlay simply drag the image file into the preview window,
or alternatively if you option-click the Overlay button you are given the
possibility of browsing for the overlay image instead of dragging it into
place.
Once in place you can click and drag the overlay image around to align it
correctly and you can resize it by clicking the borders and dragging.

Clicking the Overlay button (see page 27) will turn the overlay on/off.

The Preview

FlexColor has been designed with the philosophy that when creating
digital images, it is best to judge image quality with your eyes, not based
on point measurements and color lookup tables. This is why we have
drawn so much attention to the screen calibration procedure in the
tutorial, and why we have integrated ICC color profiles to maintain the
color accuracy you see on your screen all the way to print.

To make it easy for you to see and use the preview, FlexColor provides a
large 16-bit image with a zoom function and magnifier window. Because
your monitor can only show 8-bit colors, FlexColor calculates a new 8-bit
image from the 16-bit information each time you apply a highlight,
shadow, gradation, or color setting. This creates a very accurate preview
image.
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The Setup Window

Introduction

The Setup window shows many settings that affect the image and the way
in which the other tools in the FlexColor application work. All of the
settings displayed in the window can be saved and loaded from your hard
disk.

To open the Setup window, type cmd-U or select Setup from the File
menu.

Many of the settings, such as sharpness, gradation, and color correction,
are available individually through tool buttons in the main FlexColor
window. All settings you make using the individual tools are also applied
to the Setup window, and vice versa.

The Setup window is divided into several tab sheets to help you find the
setting you want to make.
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The FlexColor Setup Philosophy

In the traditional prepress environment, where photographs are captured
on film and then scanned, the professional scanner operator requires
extensive education and experience to make all of the settings required to
obtain good results. The operator examines each original and, applying
his or her experience, enters a "best guess" of what all the settings should
be for that particular type of original. Then the operator checks the
preview and makes fine tuning adjustments. However, when shooting
directly to digital, the photographer needs to be able to make these same
decisions.

FlexColor simplifies this process by enabling you to save a library of
setups that you use most frequently. Nearly all FlexColor settings,
including all settings in the Setup, Gradations, Histogram, and Texture
windows, are saved in each setup file.

Each time you make a capture, select the closest setup from the Setup
menu, define the crop, click on the Auto button, and you are 98 to 100% of
the way to a perfect image capture (provided that you have neutralized
the colors of your image - see "Neutralizing Colors" on page 98 for
details).

FlexColor is delivered with several generic setups to get you started
quickly. Use the Setup pop-up menu to choose a setup that is appropriate
for your original. The name of each setup indicates its intended use.

Start by using the generic setups. If you want to develop your own setup
library, begin with the closest of the available generic setups, modify it,
and save it with a new name.

Managing Setups

To create a new setup, click on the New button. A window will appear in
which you can name the new setup. All of the settings currently applied in
the Setup, Gradations, Histogram, and Texture windows will be saved in
the new file.
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To rename the currently loaded setup, click on the Rename button. A
window will appear in which you can rename the setup.

After you have made changes to the current setup, save them by clicking
on the Save button in the Setup window.

To delete the current setup, thereby removing it from the Setup pop-up
menus, click on Delete.

NOTE! The generic setups that ship with FlexColor are locked so that you
can not accidentally modify, rename or delete them. If you want to modify
a generic setup, then select the setup from the Setup pop-up menu, make
modifications, then click on New to save your new setup with a new
name.
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General Tab

The General tab of the Setup window affects the general behavior of the
interface and identifies the setup file currently loaded.

Mode

Provides a pop-up menu for choosing the color space used when you save
an image as a TIFF file. The following options are available:

• RGB: stores final images as standard 8-bit RGB TIFF files.

• RGB 16-bit: stores final images as 16-bit TIFF files. This preserves the
full color resolution captured by the camera back, but creates larger files
that many applications cannot read.

• Grayscale: creates grayscale images, such as black and white
photographs. Grayscale files are smaller than color files, so use this
mode if your originals or final publications are in black and white. To
obtain a grayscale result, FlexColor combines information from all three
RGB color channels. ICC profiles have no effect when you capture
images using this mode.

• Grayscale 16-bit: stores final images as 16-bit grayscale TIFF files. This
preserves the full tonal range captured by the camera back.
To obtain a grayscale result, FlexColor combines information from all
three RGB color channels.
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• Lineart: creates 1-bit images in which each pixel is either 100% black or
100% white. These files are even smaller than grayscale images. Use this
mode if your originals are, for example, pen and ink drawings. To
adjust the threshold at which the input will jump to either black or
white, use the Gradations window. See "Setting the Threshold for
Lineart Captures" on page 91 for more information. ICC profiles have
no effect when you use this mode.

• CMYK: creates print-ready color images. You must set up an ICC
profile to create CMYK images directly from FlexColor. See "ColorSync
or ICM Tab" on page 41 for more information about ICC profiles.

Type

Use this pop-up menu to choose which type of capture to take. You have
the following options:

• Preview: makes a single capture and applies minimal processing. This
type of capture appears most quickly on your screen. Use it to check
your exposure and composition and to make initial neutralization
settings. Preview captures are not saved and are not good enough for
production because they are not fully rendered.

• Single Shot: makes a single capture and applies full processing. If you
are capturing images of people, animals, flowing water, or other
moving objects, or if you are capturing from a hand-held camera, then
you must use single-shot mode. Single shot images are fully rendered
and processed so they take slightly longer than previews, but the results
are of production quality.

• Multi Shot: makes four captures (one for each color, but with green
captured twice for extra sharpness) and then combines them into a
single, high-resolution image. If you are capturing images of unmoving
objects, such as room interiors, studio sets or product shots, then you
can use multi-shot mode. Images taken in multi-shot mode will be
sharper and contain more detail than single-shot images. Multi-shot
images will also stand up to greater enlargement later in production.

• Micro Step: extends the multi-shot functionality by making a total of 16
captures. This creates a high-resolution image (FlexFrame 3020 = 4000 x
6000 pixels, FlexFrame/Ixpress 384 = 8000 x 8000 pixels, and Ixpress
528C = 8000 x 10800 pixels) and digital files of up to 144 MB, 384 MB,
and 528 MB respectively. Micro-step images will stand up to even
greater enlargement than multi-shot images.
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Resolution PPI

Defines the resolution of the output image. Set this value according to the
requirements for your printed output. Most high-quality color work uses
300 ppi. Newspapers typically use less (150 to 200 ppi). On-screen display,
such as for the web, requires only 72 ppi. See "Size Controls" on page 24
for more information about PPI and image sizing.

Zoom

The level of magnification applied when the image is saved. See "Size
Controls" on page 24 for more information about zooming and image
sizing.

ISO

Enables you to select between sensitivities of ISO 50 or 100. If you are
using an Ixpress camera back, you will be able to select between ISO 200
and 400 as well.
This setting will also be reflected in the Exposure Window (see page 79).

Mirror

If your original is a mirror image, or if you want to create a mirrored
image from the original, then place a check in this box. To keep the image
as captured, make sure this box is not checked.

Enhanced shadow detail

Activates an algorithm that delivers more details in the shadow areas.
This function is active by default and should only be deselected for images
with a very narrow dynamic range or for images with an unusually high
amount of color information in dark areas.
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Contrast Tab

The settings on the Contrast tab sheet are exactly the same as in the
Gradations window (available from the Window menu). Changes made
here in the Setup window will also change the settings in that window,
and vice versa. See "The Gradations Window" on page 87 for more
information about these settings.
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Texture Tab

The settings in the Texture tab reflect those made in the Texture window
(available from the Window menu).

For more information about unsharp masking, see "The Texture Window"
on page 101.

Color %

These three fields (Red, Green, and Blue) control the amount of
sharpening effect applied in each color channel. Normally, you should
leave them set to 100 each, which applies sharpening equally to all
channels. In some cases, you may be able to reduce the effect of noise by
applying less sharpening to one channel (typically the blue channel). You
can also use these settings to create special effects.

Apply

Mark this check box to apply the unsharp mask filter to all images.
Remove the check to disable the filter.
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CC (Color Correction) Tab

The CC tab contains a color correction chart, which enables you to alter
the way input colors are mapped onto the output colors. It can be used to
remove or add color cast, or to create stronger colors in your images.

The matrix contains the same settings as the Color Correction window
(available from the Window menu), and displays all of the settings you
have made using that window. In many cases, it will be easier for you to
make adjustments using the Color Correction window instead. See
"Selective Color Correction" on page 99 for more information. However,
the matrix shown here gives a better overview of all of the color correction
settings for the current setup.

To activate the color correction, mark the Apply check box. To disable the
color correction settings, remove the mark from this box. Click on the box
to toggle the mark.

To modify the amount of any one color component in the image, click on
the button next to the target color along the top of the matrix. Then use the
up and down buttons for each component color along the left side of the
matrix to add or remove that component from the target color.
Alternatively, you can click on any of the fields in the matrix and edit the
value with your keyboard.

To modify the saturation in the entire image, use the Saturation up and
down buttons or input field.
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To reduce the amount of magenta:

R G B C M Y
R 0 0 0 0 0 0 Neutral red
G 4 4 4 4 4 4 More green in all colors
B 0 0 0 0 0 0 Neutral Blue
C 0 0 0 0 0 0 Neutral Cyan
M -4 -4 -4 -4 -4 -4 Less Magenta in all colors
Y 0 0 0 0 0 0 Neutral yellow

A full explanation on all of the applications of this tool would be complex
and beyond the scope of this manual. If you would like to know more
about color mapping, please speak with your printer or consult the
electronic prepress section of your local library or book store.
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Auto Tab

The Auto tab sheet has percentage settings for both Shadow and
Highlight. When you use the Auto button, the FlexColor application
computes what it thinks the highlight and/or shadow values should be
based on the histogram of your image. It then modifies the values by the
percentages that you set here to find the final setting. The percentage is
applied to the difference between the highlight and shadow settings.

For example, if the Auto % for Highlight is set to 2 and you use the auto
function on an image in which the highlight might normally be 200, then
FlexColor will assign a highlight value of 196 (provided the shadow value
was zero). If you find that you frequently need to adjust the highlight or
shadow values to be tighter than the auto function normally chooses, then
use a positive setting here. Positive settings will result in a relative
increase in the contrast.

You are able to set negative values for the Auto % settings. This will make
the automatic controls use less extreme settings for highlight and shadow
than normal. For example, if the Auto % for Highlight were set to -2, and
you use the auto function on an image in which the highlight might
normally be 200, then FlexColor will assign a highlight value of 204
(provided the shadow value were zero). This setting will enable you to
preserve more details at the extremes of the tonal range than you
otherwise would if the highlight point were set lower.

For more information about working with highlight and shadow points,
see "The Histogram Window" on page 93.
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Dot Tab

These settings affect the output of the image brightnesses. Normally, the
output will be a maximum (255) at the brightest (highlight) point and
minimum (0) at the darkest (shadow) point for each color. However, this
can sometimes cause trouble for the printing presses, especially when too
much ink is applied for the paper to dry quickly enough.

Printers often request that images be prepared to lie within certain limits.
The settings on this tab sheet limit output at the extremes at each color.
Speak to your printer for advice about how to set these values.

The values in the three (RGB) columns control the maximum (for
highlight) or minimum (for shadow). For RGB color, 8-bit values (0 to 255)
are shown for each color.

The Endpoints pop-up menu determines how the values for the color
columns will be assigned when the input values exceed the defined limits.
They work as follows:

Software Reference - FlexColor 4.0 for Camera Backs

The Setup Window
40

Dot Tab

Cut-off:

Round-off:

Force max:

All values beyond the limit will be spread out evenly
between the limit and the maximum (0 or 255).

All values beyond the limit will be forced to the
maximum (0 or 255).

All values beyond the limit will remain at the limit.



ColorSync or ICM Tab

ICC color profiles define the color response of each device in your system.
FlexColor uses these profiles to make calibrated, accurate, and
high-quality color separations from your images.

Under Mac OS, ICC profiles are controlled by Apples ColorSync
technology and the setup tab for selecting ICC profiles in FlexColor is
called ColorSyncTM.

Under Windows, ICC technology is referred to as "ICM" (which stands for
"Image Color Management") and the tab for selecting ICC profiles in
FlexColor is called ICM.

The Ixpress digital camera backs and most monitors and output devices
include ICC profiles, which will help to make sure that the colors in your
original are maintained and that colors you see on your screen will be
accurately reproduced on paper.
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For more information about using ICC profiles, see the online help for
your operating system.

For information about Apples ColorSyncTM technology, check Apple's web
site at:
http://www.colorsync.apple.com and/or http://www.apple.com.
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Input (Mac)

This pop-up menu shows a list of input ICC profiles installed on your
system.
When selecting an input profile it is possible to choose a "Device Default
Profile", enabling you to define a setting that will always use the currently
selected device profile for the current device. To do this select the second
item in the input profile menu - it will be titled Device:<profilename>,
where <profilename> is the name of the default profile for the current
device.
To change the default profile simply click the Change button located to
the right of the input profile menu. This will lead you to the ColorSync
Utility application.

Here you simply select the Devices view which gives you a list of
registered devices. After selecting your camera or scanner in the list you
can either assign a new default profile or switch back to factory default.

The standard settings installed all use the device default profile. The
primary benefit of this feature is that you can now switch to your own
custom input profile without having to edit any of your existing settings.

Software Reference - FlexColor 4.0 for Camera Backs

The Setup Window
43

ColorSync or ICM Tab



Input (PC)

Functionality is basically the same as for Mac except that clicking the
Change button will open the Scanners and Cameras control panel which
shows the list of connected devices.
Here you can select properties for your device(s) which will bring up a
dialog box from where (e.g. Color Management tab) you can change the
color management e.g. the list of attached profile(s).
Please note that FlexColor will always choose the first profile found in the
list if more than one are present.

RGB

This pop-up menu lists all of the RGB profiles currently installed on your
system. Choose a profile that represents the color space in which you
work. (If you are using Adobe Photoshop, you can choose the space used
by Photoshop). To see which space is used by Photoshop, start Photoshop
and choose Edit -> Color Settings. The Color Settings window appears
(see the Getting Started... manual for more information about using this
window). In this example the RGB working space is the ICC profile Adobe
RGB (1998).

If you choose an RGB color space (ex. Adobe RGB 1998) you should check
both the Convert and Embed Profile fields on the ColorSync or ICM Tab.

When selecting the default output profile for RGB, FlexColor will use the
output profile as specified on the Output Profiles tab in the Preferences
window - see page 51 for details.
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CMYK

This pop-up menu lists all of the output profiles currently installed on
your system. Choose the profile specific for your output device, or select
the closest of the generic profiles supplied with FlexColor. See "Generic
ICC Output Profiles" on page 55 for more information about the generic
profiles.
When selecting the default output profile for CMYK, FlexColor will use
the output profile as specified on the Output Profiles tab in the
Preferences window - see page 51 for details.

Edit

The Edit button appears only if you are using the Mac OS version of
FlexColor. Click on this button to edit the output profile. Use this feature
only if you are an advanced user, or on the advice of your printer. For
more information about editing ColorSync profiles, see "Editing
ColorSync Color Profiles" on page 56.

Gray

FlexColor offers full ICC support even when saving images in grayscale.
To do so simply check the required Embed and Convert options, and if
you have checked Convert you also need to select a grayscale output
profile from the menu.
Please note that you do not need to select a different input profile when in
grayscale mode, as a suitable grayscale input profile is automatically
generated based on the currently selected RGB input profile.
When selecting the default output profile for Grayscale, FlexColor will use
the output profile as specified on the Output Profiles tab in the
Preferences window - see page 51 for details.

Embed Profile

Mark this checkbox to embed a profile with your saved image. The
embedded profile will always match the content of the file. If conversion
is active the embedded profile will be the output profile corresponding to
the current capture mode setting - either the RGB or the CMYK profile. If
the convert checkbox is not checked the embedded profile will be the
current input profile.
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Convert

If this checkbox is marked data will be converted according to the current
settings of input and output profile. Otherwise the output files will
contain data without any ICC corrections applied.

Softproof

Mark this checkbox to see an on-screen representation of the colors
expected from your output device. It combines the output profile with the
monitor profile selected for your system to create a simulation of the
output colors. See the Getting Started... manual for instructions on how to
set up a monitor profile for you system and for advice about using the
Softproof feature.
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The Preferences Window

Introduction

The Preferences window contains several miscellaneous settings that
control the general functions of the camera back and the software. The
Preferences window settings are universal for the FlexColor application,
they are not saved with the other settings in the setup files.
To open the window, select Preferences from the FlexColor menu.

Scanner Tab

For scanners only!

Camera Tab

The Camera tab holds the following settings for your current device:

Model

FlexColor must know which kind of camera body you are using so that it
can control the camera correctly. Choose your camera body from the
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Model pop-up menu before you start taking pictures for the first time and
each time you change the type of camera body that you are using with the
camera back.
To set the Model list to show only cameras compatible with your current
camera back, mark the Show recommended only check box.
If you are using an unlisted camera body, then chose Generic. In this case,
you may need to experiment a bit with the Shutter delay setting to
optimize your results (see below).

Shutter Delay

When you click on the Capture button in FlexColor, a short amount of
time elapses between the moment you issue the expose command and the
moment the flash is fired. The camera body needs to allow some time for
its internal mechanics to, for example, move the mirror and open the
shutter. FlexColor must know this time so that it can correctly
synchronize the shutter, flash and CCD exposure.

The shutter delay time is different for each camera back model. The delay
is set automatically when you choose a camera body from the Model
pop-up menu. However, you must set this manually when you choose the
Generic setting.

NOTE! Even when working with a specific camera body, you are able to
adjust the shutter delay time manually if necessary. The value is resettable
by clicking the Default button.

Under normal circumstances you simply choose the preferred camera
from the drop down menu. You could however experience that your
camera does not perform correctly using the default shutter delay, causing
colors to slide or other unwanted effects. This is due to a timing error in
the camera different from the factory setting.
To correct this you are enabled to alter the default shutter delay settings. If
you experience problems start by increasing the delay quite a bit, for
example 100 ms. Then decrease the shutter delay in small steps until your
image looks right. This way you will find the correct synchronization for
your selected camera.
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Flash Delay

When you use one of the multi-exposure modes, FlexColor will instruct
the camera back to make the captures as quickly as possible, allowing time
for the image data to download after each capture. If your flash system
requires extra time beyond this to be ready to flash again, then enter the
required minimum charge time (in seconds) in the Flash delay field.

Process and store full image when saving

Check this if you want to avoid updating the 3f files with the processed
info when saving from these. In this case processing will only be done for
the actual cropped area and your unprocessed 3f file will stay small and
unprocessed.
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3f Tab

When you make a capture, the image is saved as a 3f file in the currently
selected folder. The 3f file can contain various information about the file,
as described in “The 3f File Format” on page 10 earlier in this manual.

Scan Size

These settings are only relevant when using FlexColor with a scanner
device.

Default Info

Prior to taking a number of captures where you want to add the same
name and copyright information to all of the shots, you can type this
information in the Byline and Copyright fields. Later when opening the
Info window for one or more of the captures, this information will show
up in the corresponding fields here. See “The Info Window” on page 65
for references.
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Output Profiles Tab

Here it is possible to define the default output profiles for RGB, CMYK
and Grayscale. In the setup ColorSync tab you can choose to use the
default profile instead of specifying a specific output profile.
The standard settings will specify the default output profiles for all color
spaces. Therefore it’s possible to change the specific output profile used by
all standard settings simply by selecting another profile in the Output
Profiles tab.
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General FlexColor Settings

The bottom of the Preferences window shows the following general
FlexColor settings:

Opening Saved Images

After saving an image as a TIFF file, FlexColor is able to launch the
application of your choice and open the saved image in that application. If
you would like to use this feature, place a check in the Open in checkbox,
then click the Select button. Use the appearing standard file finder
window to locate and select the application you would like to use for
viewing your saved images.

Auto after New Crop

FlexColor includes an auto tonal range function, which analyzes the
cropped image and sets highlight and shadow values accordingly. You
can use it at any time by clicking on the Auto button in the main
FlexColor window.

The Auto after new crop checkbox provides an optional shortcut for using
the auto function. When this checkbox is marked, each time you make a
new crop, FlexColor will immediately analyze the image contained in the
crop area and set highlight and shadow values, just as if you had clicked
on the Auto button.

You can also control this function by holding down the option key as you
define a new crop:

• If the Auto after new crop checkbox is enabled, then hold down the
option key to make a new crop without invoking the auto function.

• If the Auto after new crop checkbox is disabled, then hold down the
option key to apply the auto function to your new crop.

NOTE! This function will not update the highlight and shadow settings
when you move or resize an existing crop area; it only responds when you
create a new crop area. If you would like to use the auto function again
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after moving or resizing a crop area, click on the Auto button in the main
FlexColor window.
For more information about tonal range and the Auto function, see "The
Histogram Window" on page 93 and "Auto Tab" on page 39. For more
information about cropping, see "The Main FlexColor Window" on page
21.

Show units in cm

Check this box if you want the Height and Width values in the main
FlexColor window to be displayed in cm. If this box is not checked, the
values will be displayed in inches.
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FlexColor ICC Profiles

Generic ICC Output Profiles

FlexColor includes six generic ICC output profiles for generating various
types of color separations. The name of each profile provides a description
of the results it creates. See Table 1 for details.

GCR stands for gray color replacement. It is a scheme for adding black to
dark colors, thereby reducing the total amount of ink applied. A high
percentage of GCR results in more black ink in the image (and,
consequently, less ink of other colors).

The skeleton black scheme does not add nearly as much black - especially
in the colors, thus resulting in brighter colors, but also requiring higher
quality paper. These profiles also specify the minimum ink percentage in
each channel that a color must have before any black is added at all.

If you are not sure which profile to use, ask your printer if there is a limit
on the maximum ink percentage and be sure to choose a profile that limits
the percentage appropriately. In the majority of cases, the Imacon 330%
Skel. K. 75/30% profile will provide the best results.
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Profile
Max

Ink

Black

Generation

Max

Black

Black

Starts
Use

Imacon 250%

GCR 40% K.90%

250% GCR 40% 90% n/a Newspapers,
low ink

Imacon 280%

GCR 30% K.90%

280% GCR 30% 90% n/a Newspapers,
standard

Imacon 330%

GCR 20% K.95%

330% GCR 20% 95% n/a Glossy paper
(magazines)

Imacon 330%

Skel. K. 75/30%

330% Skeleton
Black

75% 30% General use,
glossy paper

Imacon 350%

GCR 20% K.95%

350% GCR 20% 95% n/a High-end, high
ink

Imacon 350%

Skel. K. 91/30%

350% Skeleton
Black

91% 30% Extreme high-
end (e.g. art repro)

Table 1: Generic ICC output profiles included with FlexColor.



In some cases, an ICC profile for your (or your service bureaus) specific
output device may be available. If so, then use it instead.

If your results are not satisfactory, then speak with your printer for advice
about how you should modify the profile. See "Editing ColorSync Color
Profiles" on page 56 for instructions.

Editing ColorSync Color Profiles

NOTE! The profile editor is only available with the Mac OS version of
FlexColor.

FlexColor includes both a ColorSync input profile designed for the Ixpress
digital camera backs and a set of generic output profiles, each of which is
designed to create good results under a different set of conditions.

These generic profiles will deliver adequate to excellent results. If, after
testing an output profile and speaking with your service bureau, you find
that you would like to fine tune an output profile, then follow the
procedure below.

The settings available for editing the output profiles are both highly
detailed and very powerful. In general, they are intended for users who
are very experienced in making color separations. Most likely, you should
speak with your service bureau about how to make these settings.
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1. Run the FlexColor application.

2. Choose Setup from the File menu. Then click on the ColorSyncTM tab.

3. Use the CMYK pop-up menu to select the profile you would like to
edit. Note that the profile you select must be as close as possible to the
profile you want to make - you are not able to create a completely
different profile using the editor. The menu lists all of the profiles
currently installed in the ColorSyncTM Profiles folder in the
Preferences folder of your System Folder.

4. Click on the Edit button. The Output Profile window appears.

5. We recommend that you save your edited profile using a new name,
so click on the Save as button.
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The Create New Profile window appears. Type a name for your
edited profile and click on the Create button.

6. Return to the Output Profile window. It shows the output values
applied in the final separated file for each color at each of four
brightness (neutral-gray) levels (0%, 5%, 50%, and 100%). By adjusting
these levels, you are able to control how colors will appear in your
output. For example, if your prints look too yellow in the highlights,
then you could turn down the Y value for 0% and/or 5% values. In
many cases, this is all the level of detail you will need.

7. The Dot Gain Compensation setting compensates for the default
dot-gain setting of the existing profile. The setting is relative, and can
be positive or negative. Generally, this value varies from printer to
printer. Finding the correct setting will require some trial and error.

Software Reference - FlexColor 4.0 for Camera Backs

FlexColor ICC Profiles
58

Editing ColorSync Color Profiles



8. If you need to make even more detailed adjustments, then click on the
triangle next to the Advanced heading.

9. The Advanced section includes value settings for even more gray
levels. These settings include the same four levels that you were able
to adjust using the standard part of the Output Profile window.

10. When you are done making settings in the window, click on the Save
button to apply the settings to your new profile.
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The Thumbnails Window

Introduction

The Thumbnails window works like a light table, showing you a small
preview image of each of the captures stored in a the currently selected
folder. Use the Thumbnails window to review your work, load images
into the main FlexColor window and to save images as standard TIFF
files.

Opening the Thumbnails Window

To open the Thumbnails window, type cmd-8 or click on the
Thumbnails button in the main FlexColor window or select
Thumbnails from the Window menu.
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Selecting a Thumbnails Folder

Use the folder pop-up menu to select the folder you want to use for your
thumbnails. The menu contains both recent and favourite locations. The
name of the current folder (ex. My Pictures) appears in the title bar of the
Thumbnails window.

Files and Formats

When you make a capture, the image is saved as a 3f file in the currently
selected folder and displayed in the preview area of the main FlexColor
window.

See “The 3f File Format” on page 10 earlier in this manual for a detailed
description.

The Thumbnails window shows all of the 3f files saved in the currently
selected folder and allows you to load any of them in the preview area of
the main FlexColor window.

Saving Crop and Imaging Settings

All of the crop, mode, color and image-enhancement settings in effect
when capturing an image will be saved with the 3f file in the current
folder. If you make new settings with the various tools of FlexColor while
a capture is loaded into the main FlexColor window, your new settings
will not be saved unless you click on Save in the main FlexColor window.
When you do this, FlexColor will create a TIFF file of the current image in
which all of the current crop, mode, color and image-enhancement
settings are applied. In addition, the settings will be saved as an entry in
the History list of the Info window for the current 3f file.
See “The Info Window” on page 65 for details.

When you load a file from the Thumbnails window into the main
FlexColor window, all of the crop, mode, color and image-enhancement
settings currently selected as default for the 3f file will also be loaded into
FlexColor.
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Using the Thumbnails Window

Viewing the Thumbnails Display

You have two types of options for controlling how the thumbnails will be
displayed in the Thumbnails window:

Sort by Use this pop-up menu to choose whether the thumbnails
should be sorted by Date (the order in which they were
created) or by Name. If you wish to reverse the sorting order
click the Descending/Ascending button to the right of the
pop-up.
Also it is possible to sort the captures by their approval
status by checking the … and approval checkbox.

Size Use this pop-up menu to choose how large you would like
the icons to appear in the Thumbnails window.

Crop mask button: Masks off the area outside the current
cropping (if any) for each image.
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The Thumbnails window displays information about each capture:

The "Capture type" will be shown as one of the following values:

• 1 for single-shot and the preview-shot

• 4 for multi-shot

• 16 for micro-step
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After capturing, a preview image is shown as quickly as possible in the
main FlexColor window. However, extra processing is still required
before you can view the image in full resolution (See "Processing
Workflow" on page 100 for further details).

Selecting Images

You are able to select one or more images in the Thumbnails window.
Once you have selected an image, it will be shown highlighted. Then you
are able to, for example, rename, delete, view or save it.

Use the following techniques to select images:

• Click once on an icon to select a single image.

• Cmd-click to select several images.

• Select several images by dragging the mouse cursor across them.

• Shift-click to select a consecutive row of images.

• Press cmd-a or choose Select All from the Edit menu to select all of the
icons in the Thumbnails window.

• Press and hold cmd-key then use left or right keys to open previous or
next image respectively.

Working with Selected Images

The Thumbnails window includes the following controls, which operate
on the images you have highlighted:

Please note that if you ctrl-click on a thumbnail you will get a contextual
menu containing most of the functions described below.

Get Info Opens the Info window, that holds various information
about the image, such as size, resolution, exposure time and
various information about copyright etc. (you can also
choose Get Info from the File menu or type cmd-I to open
the Info window).
Note that an Info window will be displayed for each of the
selected files.
See "The Info Window" on page 65 for a detailed description.

Delete Moves the currently selected image(s) to the Trash. You will
be asked to confirm the operation. Pressing the command
(cmd) key while clicking Delete will move the image(s)
without confirmation.
Note that you can delete the images using the del or cmd-del
keys on your keyboard as well.
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Show Displays the currently selected image in the main FlexColor
window, where you can view and work with it (this can also
be obtained by double-clicking on an icon). The crop, mode,
color and image-enhancement settings selected as default for
the selected file will also be loaded into FlexColor. The
button is only available when you have selected a single
image.

Please note that when double-clicking an icon or clicking the
Show button, a low-resolution image will be displayed
immediately in the preview window.
If image has already been processed, the high resolution
preview is being processed in the background and when
finished the preview is updated (typically after 20-30 secs).

Save This button saves all of the currently selected Thumbnails
images. When you click the button, the Batch Save window
appears, asking if you would like to save using the
Individual settings & cropping saved with each file, or to
apply the Current settings & cropping (as seen in the
current preview of the main FlexColor window) to all
captures.

Choose either of the settings and then use the Mode pop-up
menu to select one of the following save options:

Normal: to save the selected images as TIFF-files.

Preview: to save the selected images as a low-resolution
TIFF-file for preview purposes.

Layers: to save the selected images as separate layers in
a Photoshop file (.psd)

Having selected the appropriate save options, click the Save
button.
Previews are saved in the foreground while saving images
using the Normal or Layers modes will take place in the
background and the save tasks will be added to the list in
the Task window (see "The Task window" on page 111 for
details).
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